ĐỀ KIỂM TRA CUỐI HỌC KÌ II-ĐỀ 1
NĂM HỌC 2024 - 2025
MÔN: Tin học 8
Thời gian làm bài : 45 Phút (không kể giao đề)
I. PHẦN TRẮC NGHIỆM (7,0 điểm)
1. Dạng trắc nghiệm nhiều lựa chọn (3,0 điểm)
Học sinh trả lời từ câu 1 đến câu 12. Mỗi câu hỏi học sinh chỉ chọn một phương án.
Học sinh điền phương án đúng nhất vào bảng sau:
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Trả lời
	
	
	
	
	
	
	
	
	
	
	
	


[image: A screenshot of a phone  Description automatically generated with low confidence]Câu 1. Câu lệnh điều khiển nhân vật Di chuyển 10 bước, xoay phải 15 độ được lặp lại bao nhiêu lần?
A. 3   
B. 10
C. 15                     
D. Không xác định

Câu 2: Phương án nào sau đây là sai:
A. Ở chế độ Slide, em không thể thêm được đầu trang.
B. Ở chế độ Notes and Handouts (chế độ in nội dung bài trình chiếu), em không thể thêm được đầu trang.
C. Trong cửa sổ Header and Footer chọn lệnh Apply để áp dụng cho các trang chiếu đang được chọn.
D. Trong cửa sổ Header and Footer chọn lệnh Apply to All để áp dụng cho tất cả các trang chiếu trong bài trình chiếu.
Câu 3: Hãy chọn phương án đúng?
A. Nháy chuột chọn Design/Themes để sử dụng bản mẫu có sẵn.
B. Nháy chuột chọn Design/Themes để áp dụng một mẫu định dạng có sẵn.
C. Nháy chuột chọn File/Insert để sử dụng một bản mẫu có sẵn
D. Nháy chuột chọn File/New để áp dụng một mẫu định dạng có sẵn.
Câu 4: Cho biểu thức tính chỉ số BMI của cơ thể như hình sau 
[image: ]Biểu thức này trả lại giá trị thuộc kiểu dữ liệu nào? 
A. Kiểu số				B. Kiểu xâu kí tự
C. Kiểu logic			D. Không xác định
Câu 5: Bạn An muốn tạo chương trình tính diện tích hình chữ nhật theo công thức s=a*b. Bạn cần sử dụng bao nhiêu biến?
A. Sử dụng 2 biến a và b để lưu giá trị chiều dài và chiều rộng
B. Sử dụng 2 biến s và b để lưu giá trị diện tích và chiều rộng
C. Sử dụng 2 biến s và a để lưu giá trị diện tích và chiều dài
D. Sử dụng 3 biến s,a,b để lưu giá trị diện tích, chiều dài và chiều rộng
Câu 6: Phần mở rộng của bản mẫu (Template) là
A  .docx		B   .xlsx		C  .potx		D  .exe
[image: ]Câu 7. Câu lệnh dưới đây thể hiện cấu trúc điều khiển nào? 
A. Cấu trúc tuần tự                     B. Cấu trúc rẽ nhánh dạng thiếu
C. Cấu trúc lặp                           D. Cấu trúc rẽ nhánh đầy đủ
Câu 8. Em hãy sắp xếp lại các bước để thêm đầu trang vào bài trình chiếu sao cho đúng
a) Nháy chuột chọn Insert
b) Trong nhóm lệnh Text chọn lệnh header and footer
c) Nháy chuột chọn Apply to All để thêm đầu trang vào tất cả các trang trong bài trình chiếu.
d) Trong cửa sổ Header and Footer chọn trang Notes and Handout
e) Nhập nội dung muốn xuất hiện ở đầu trang vào ô bên dưới mục Header
f) Nháy chuột vào ô đứng trước mục Header để đánh dấu chọn
A. b,a,d,f,c,e                                    		B. d,a,f,c,b,e                                    
C. a,d,f,b,c,e                                    		D. a,b,d,f,e,c
Câu 9:  Với trường hợp nhân vật di chuyển theo đường đi là một tam giác đều thì góc quay của nhân vật khi đi hết một cạnh là
A. 360°		B. 90°				C. 120°		D. 0°
Câu 10: Chương trình máy tính là gì?
A. Các lệnh trong chương trình được thực hiện tuần tự từ trên xuống dưới.
B. Các lệnh viết bằng ngôn ngữ lập trình chỉ dẫn máy tính thực hiện các bước của thuật toán.
C. Là bước thực hiện công việc đó.
D. Các bước của thuật toán được thực hiện tuần tự từ trên xuống dưới.
Câu 11: Đại lượng được đặt tên dùng để lưu trữ dữ liệu, có giá trị không đổi trong suốt quá trình thực hiện chương trình được gọi là:
A. Tên		B. Từ khóa			C. Biến		D. Hằng
Câu 12: Chọn phát biểu đúng nhất về hoạt động gỡ lỗi.
A. Gỡ lỗi là phát hiện và loại bỏ lỗi. Trong lập trình, không nhất thiết phải gỡ lỗi.
B. Gỡ lỗi là chạy thử chương trình để phát hiện lỗi. Trong lập trình, không nhất thiết phải gỡ lỗi.
C. Gỡ lỗi là chạy thử chương trình để phát hiện lỗi. Gỡ lỗi là một phần quan trọng của lập trình.
D. Gỡ lỗi là phát hiện và loại bỏ lỗi. Gỡ lỗi là một phần quan trọng của lập trình.
2. Trắc nghiệm đúng sai (4 điểm)
Học sinh trả lời từ câu 13 đến câu 16. Trong mỗi ý a), b), c), d) ở mỗi câu, học sinh chọn đúng hoặc sai. Học sinh điền đúng (Đ); sai (S) vào bảng dưới đây:
	Câu
	13a
	13b
	13c
	13d
	14a
	14b
	14c
	14d
	15a
	15b
	15c
	15d
	16a
	16b
	16c
	16d

	Đáp án
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


Câu 13: Cho văn bản sau:
[bookmark: _Hlk190509023]Danh sách lớp

· 8A
· 8B
· 8C

a. Văn bản trên sử dụng danh sách dạng liệt kê
b. Văn bản trên sử dụng danh sách dạng liệt kê kiểu danh sách có thứ tự.
c. Để chèn hình ảnh mũi tên vào văn bản trên, có thể dùng chức năng Insert Symbol
d. Để hình ảnh mũi tên được chèn vào vị trí như trên, sau khi chèn ảnh, em thực hiện thao tác: Chọn ảnh -> Chọn Format -> Trong nhóm lệnh Arrange, nháy chuột vào mũi tên cạnh lệnh Wrap text, rồi chọn lệnh Behind Text
Câu 14: Trong giờ Tin học, An, Bình và Chi cùng nhau tạo một trò chơi đơn giản trên Scratch. An dùng lệnh để chỉ khi nhấn phím cách nhân vật mới kêu. Bình dùng lệnh để nhân vật di chuyển lặp lại. Chi tạo một biến đếm điểm và thấy nó thay đổi. Khi gặp lỗi, cả nhóm chạy thử từng bước để tìm nguyên nhân. Dựa trên những hoạt động này, nhóm đã đưa ra các nhận định sau về Scratch như sau:
a) Cấu trúc rẽ nhánh Nếu – thì trong Scratch được sử dụng để kiểm tra một điều kiện và thực hiện hành động nếu điều kiện đó sai.
b) Một biến trong Scratch có thể thay đổi giá trị trong suốt quá trình chương trình chạy.
c) Khối lệnh  trong cấu trúc Lặp lại… trong Scratch thực hiện một hành động chỉ một lần. 
d) Trong Scratch, để phát hiện lỗi logic phải chạy chương trình từng bước, theo dõi sự thay đổi của biến, các giá trị đầu ra và so sánh với các giá trị tính được theo cách thủ công.
Câu 15: Cho đoạn chương trình sau:
[image: A screenshot of a computer  AI-generated content may be incorrect.]
a. Đoạn chương trình có sử dụng cấu trúc lặp
b. Đoạn chương trình có sử dụng 01 biến là biến Tổng kiểu dữ liệu số
c. Vòng lặp của đoạn chương trình sẽ lặp lại 10 lần
d. Sau khi chạy đoạn chương trình trên, giá trị của biến Tổng sẽ là 45
Câu 16. Nhóm Hà, Nam, Trang chuẩn bị bài thuyết trình về "Bảo vệ môi trường" và dự định sử dụng PowerPoint để: chèn video từ web, liên kết đến file PDF, và tùy chỉnh mẫu có sẵn để tạo sản phẩm số phục vụ học tập. Dựa trên những dự định này, nhóm đã đưa ra các nhận định sau về PowerPoint: 
a) Trong PowerPoint, bạn có thể chèn một đường dẫn đến video từ Internet vào trong trang chiếu. 
b) Trong PowerPoint, bạn không thể liên kết đến một tài liệu khác (ví dụ: file PDF hoặc Word) vào trang chiếu. 
c) Khi sử dụng bản mẫu trong PowerPoint, bạn có thể thay đổi nội dung nhưng thiết kế tổng thể của bản mẫu sẽ không thay đổi. 
d) Trong PowerPoint, không tạo được các sản phẩm số phục vụ học tập, giao lưu và trao đổi thông tin. 
II. PHẦN TỰ LUẬN (3 điểm)
Câu 17: (1,0 điểm): Em hãy giải thích vai trò của đầu trang (Header) và chân trang (Footer) trong văn bản. Đồng thời, nêu cách ứng dụng chúng trong một tài liệu thực tế.
Câu 18: (2,0 điểm) Cho sơ đồ thuật toán như hình sau:
[image: ]
a) Thuật toán giải quyết nhiệm vụ gì?
b) Xác định đầu vào, đầu ra của thuật toán?
c) Xác định hằng, biến, biểu thức trong thuật toán và kiểu dữ liệu của chúng?

ĐÁP ÁN
I. TRẮC NGHIỆM (7 điểm)
1. Trắc nghiệm nhiều lựa chọn (3 điểm)
Mỗi câu đúng được 0,25 điểm
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Đáp án
	A
	B
	B
	A
	A
	C
	B
	D
	C
	B
	D
	D


2. Trắc nghiệm đúng sai (4 điểm)
Mỗi ý điền đúng được 0,25 điểm
	Câu 13
	Câu 14
	Câu 15
	Câu 16

	a-Đ
	b-S
	c-Đ 
	d-S
	a-S
	b-Đ 
	c-S
	d-Đ
	a-Đ
	b-S
	c-S
	d-Đ
	a-Đ
	b-S
	c-Đ
	d-S


II. PHẦN TỰ LUẬN (3 điểm)
	Câu
	Hướng dẫn chấm
	Điểm

	Câu 17
	- Đầu trang và chân trang giúp hiển thị thông tin quan trọng như số trang, tiêu đề tài liệu, tên tác giả trên tất cả các trang một cách tự động.
- Chúng giúp tài liệu có bố cục chuyên nghiệp, dễ theo dõi, đặc biệt với tài liệu dài nhiều trang.
-  Trong bài báo cáo môn học, có thể sử dụng Header để hiển thị tên bài báo cáo, tên học sinh, lớp học và Footer để đánh số trang tự động.
-  Trong luận văn hoặc tài liệu hướng dẫn, có thể chèn tên chương vào đầu trang và số trang vào chân trang để giúp người đọc dễ tra cứu nội dung.
	0,25


0,25

0,25

0,25

	Câu 18
	a) Thuật toán tính diện tích hình tam giác
b) Đầu vào: Cạnh đáy, chiều cao
    Đầu ra: Diện tích tam giác
c) - Hằng kiểu số: 
            1/2
    - Biến kiểu số: 
            Cạnh đáy, Chiều cao
    - Biểu thức kiểu số:
           1/2*Cạnh đáy*Chiều cao
	0,25
0,25
0,25
0,25
0,25
0,25
0,25
0,25
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Thời gian làm bài : 45 Phút (không kể giao đề)

I. PHẦN TRẮC NGHIỆM (7,0 điểm)
1. Dạng trắc nghiệm nhiều lựa chọn (3,0 điểm)
Học sinh trả lời từ câu 1 đến câu 12. Mỗi câu hỏi học sinh chỉ chọn một phương án.
Học sinh điền phương án đúng nhất vào bảng sau:
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Trả lời
	
	
	
	
	
	
	
	
	
	
	
	


Câu 1. Phát biểu nào sau đây sai?
A. Bản mẫu được lưu dưới dạng một tệp có phần mở rộng là .potx.
B. Bản mẫu không gợi ý các nội dung cần có cho bài trình chiếu.
C. Bản mẫu giúp bài trình chiếu có giao diện thống nhất, chuyên nghiệp mà không tốn thời gian.
D. Các bản mẫu được sắp xếp theo các chủ đề để người dùng dễ lựa chọn.
Câu 2. Trong chương trình Scratch, nhóm lệnh nào dùng để tạo biểu thức?
A. Nhóm lệnh Hiển thị.			B. Nhóm lệnh Sự kiện.
C. Nhóm lệnh Các biến số.			D. Nhóm lệnh Các phép toán.
Câu 3. Các thao tác có thể thực hiện với bản mẫu là:
A. Chia sẻ, tái sử dụng, tạo mới.		B. Chỉnh sửa, chia sẻ, tạo mới.
C. Chỉnh sửa, chia sẻ, tái sử dụng.		D. Tạo mới, chỉnh sửa, tái sử dụng.
Câu 4. Màu xanh dương thuộc nhóm màu:
A. Ấm.			B. Lạnh.		C. Trung tính.		D. Nóng.
Câu 5. Có mấy cách mô tả thuật toán?
A. 1.			B. 2.			C. 3.				D. 4.
Câu 6. Thuật toán so sánh hai giá trị có thể được mô tả dưới dạng:
A. Cấu trúc lặp.				B. Cấu trúc tuần tự.
C. Cấu trúc dữ liệu.				D. Cấu trúc rẽ nhánh.
Câu 7. Phép toán nào sau đây trả lại kết quả true?
[image: https://i.vdoc.vn/data/image/2024/04/09/tin-hoc-8-kntt-2.png]
Câu 8. Các bước đánh số trang vào vị trí giữa, bên dưới trang văn bản là:
A. Layout => Page Number => Bottom of Page/Plain Number 2.
B. Insert => Page Number => Bottom of Page/Plain Number 2.
C. Design => Page Number =>Bottom of Page/Plain Number 2.
D. Home => Page Number=> Bottom of Page/Plain Number 2.
Câu 9. Kịch bản điều khiển một nhân vật có thể được mô tả dưới dạng:
A. Văn bản.		B. Video.		C. Thuật toán.			D. Hình ảnh.
Câu 10. Để đưa vào trang chiếu đường dẫn đến một video (hay tài liệu khác), ta sử dụng lệnh nào trên dải lệnh Insert?
A. Link.		B. Symbol.				C. Icons.		D. Video.
	Câu 11: Sơ đồ khối như hình bên mô tả thuật toán nào?
A. Giải phương trình bậc nhất
B. So sánh 2 số x, y
C. Tính tổng 2 số x, y
D. Tính tích 2 số x, y.
	[image: 4 Đề thi Học kì 2 Tin học 8 Kết nối tri thức (có đáp án, cấu trúc mới)]


Câu 12: Bạn Khoa muốn tạo chương trình tính quảng đường đi của một phương tiện dựa trên vận tốc và thời gian theo công thức s = v x t. Bạn cần sử dụng các biến nào?
A. Sử dụng 2 biến v và t để lưu giá trị vận tốc và thời gian.
B. Sử dụng 2 biến s và t để lưu giá trị quảng đường và thời gian.
C. Sử dụng 2 biến s và v để lưu giá trị quảng đường và vận tốc.
D. Sử dụng 2 biến s, v, t để lưu giá trị quảng đường, vận tốc và thời gian.
2. Trắc nghiệm đúng sai (4 điểm)
Học sinh trả lời từ câu 13 đến câu 16. Trong mỗi ý a), b), c), d) ở mỗi câu, học sinh chọn đúng hoặc sai. Học sinh điền đúng (Đ); sai (S) vào bảng dưới đây:
	Câu
	13a
	13b
	13c
	13d
	14a
	14b
	14c
	14d
	15a
	15b
	15c
	15d
	16a
	16b
	16c
	16d

	Đáp án
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


Câu 13: Bạn Lan, học sinh lớp 8, được giao bài tập môn Tin học để thiết kế một bài trình chiếu PowerPoint với chủ đề "Bảo vệ môi trường". Giáo viên yêu cầu bài trình chiếu cần rõ ràng, có bố cục hợp lý và sử dụng các mẫu bài trình chiếu (template) sẵn có để tiết kiệm thời gian:
a) Có thể sử dụng mẫu bài trình chiếu sẵn có trong PowerPoint để tạo bài trình bày nhanh hơn. 
b) Mẫu bài trình chiếu có thể tùy chỉnh để thay đổi màu sắc và phông chữ theo ý muốn. 
c) Khi sử dụng mẫu bài trình chiếu, không thể thêm các đối tượng như hình ảnh, video hay biểu đồ. 
d) Không thể thay đổi nội dung hoặc xóa các phần không cần thiết trong mẫu bài trình chiếu. 
Câu 14: Bạn Nam, học sinh lớp 8, được giao bài tập trong môn Tin học yêu cầu lập trình trên Scratch để giải quyết bài toán sau: "Viết chương trình nhập vào hai số và hiển thị tổng của chúng." Nam cần thực hiện các bước từ việc xây dựng thuật toán đến lập trình bằng Scratch để hoàn thành bài tập này.
a) Thuật toán giúp xác định rõ các bước cần thực hiện trước khi lập trình. 
b) Chương trình Scratch không thể thực hiện phép toán cộng. 
c) Thuật toán cần xác định rõ điều kiện kiểm tra trước khi lập trình.
d) Nếu người dùng nhập giá trị không phải số (như chữ), chương trình Scratch sẽ báo lỗi. 
Câu 15. An đang soạn thảo một văn bản dài và quyết định đánh số trang để làm cho văn bản dễ dàng theo dõi hơn. Cô nhận thấy rằng đánh số trang không chỉ giúp người đọc xác định độ dài của văn bản, mà còn kết hợp với mục lục để người đọc nhanh chóng tìm được phần mình cần. Việc này rất hữu ích khi trích dẫn một trang cụ thể trong văn bản. Hầu hết các phần mềm soạn thảo văn bản hiện nay đều hỗ trợ tính năng này, giúp tiết kiệm thời gian và công sức cho người dùng.
Sau đây là một số nhận định:
a) Đánh số trang giúp người đọc biết độ dài của văn bản (nhìn số trang cuối).
b) Đánh số trang, cùng với mục lục, giúp người đọc dễ dàng tìm thấy các phần cụ thể của văn bản.
c) Đánh số trang cho phép trích dẫn một trang cụ thể của văn bản.
d) Phần mềm soạn thảo văn bản không có chức năng đánh số trang tự động.
[image: ]Câu 16. Bạn Mai đang học về lập trình Scratch. Bạn ấy đã thử nghiệm một đoạn code sau:     
a) Chương trình trên vẽ một hình vuông.
b) Nếu thay đổi "(4)" thành "(5)", hình được vẽ sẽ là hình ngũ giác đều.
c) Nếu thay đổi số "90" trong đoạn code trên, hình dạng tạo ra sẽ không còn là hình vuông.
d) Khối lệnh "Di chuyển 100 bước" dùng để di chuyển nhân vật về phía sau. 
II. PHẦN TỰ LUẬN (3 điểm)
Câu 18: (1,0 điểm) Em hãy trình bày cách sử dụng bản mẫu (Template) trong phần mềm trình chiếu để tạo một bài thuyết trình chuyên nghiệp.
Câu 19: (2,0 điểm) Cho sơ đồ khối thuật toán tính tiền phạt đối với hàng hóa quá hạn như hình sau:
[image: ]
? Xác định hằng, biến, biểu thức trong thuật toán và kiểu dữ liệu của chúng?

ĐÁP ÁN

I. TRẮC NGHIỆM (7 điểm)
1. Trắc nghiệm nhiều lựa chọn (3 điểm)
Mỗi câu đúng được 0,25 điểm
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Đáp án
	B
	D
	C
	B
	B
	D
	A
	B
	C
	A
	B
	A


2. Trắc nghiệm đúng sai (4 điểm)
Mỗi ý điền đúng được 0,25 điểm
	Câu 13
	Câu 14
	Câu 15
	Câu 16

	a-Đ
	b-Đ
	c-S 
	d-S
	a-Đ
	b-S 
	c-Đ
	d-S
	a-Đ
	b-Đ
	c-S
	d-S
	a-Đ
	b-S
	c-Đ
	d-S


II. PHẦN TỰ LUẬN (3 điểm)
	Câu
	Hướng dẫn chấm
	Điểm

	Câu 17
	- Chọn bản mẫu phù hợp: Khi tạo bài trình chiếu, vào Design → Themes, chọn một mẫu có bố cục, màu sắc phù hợp với chủ đề.
- Chỉnh sửa nội dung theo bản mẫu: Thay đổi tiêu đề, nội dung, hình ảnh dựa trên bố cục sẵn có, giúp bài trình chiếu đồng nhất và chuyên nghiệp.
- Tùy chỉnh phông chữ và màu sắc: Điều chỉnh phông chữ, kích thước, màu nền để đảm bảo dễ đọc, có độ tương phản tốt với nội dung.
- Lưu và tái sử dụng bản mẫu: Nếu muốn dùng lại trong các bài trình chiếu khác, chọn File → Save As → PowerPoint Template (.potx) để lưu bản mẫu cá nhân.
	 0,25


0,25


0,25


0,25

	Câu 18
	  - Hằng kiểu số: 
            0.3
    - Biến kiểu số: 
            Đơn giá, ngày quá hạn, số ngày quá hạn
    - Biểu thức kiểu số:
           0.3*Số ngày quá hạn*Đơn giá
    - Biểu thức logic:
          Số ngày quá hạn > 0
	0,25
0,25
0,25
0,25
0,25
0,25
0,25
0,25














                                                                                                         Trang 1
[bookmark: _GoBack]MA TRẬN ĐỀ KIỂM TRA CUỐI HỌC KÌ II
MÔN TIN HỌC, LỚP 8

	TT
	
Chủ đề/ Chương
	Nội dung/Đơn vị kiến thức
	
	Mức độ đánh giá
	Tổng
	Tỉ lệ % điểm

	
	
	
	TNKQ
	Tự luận
	
	

	
	
	
	Nhiều lựa chọn
	“Đúng - Sai”
	
	
	

	
	
	
	Biết
	Hiểu
	Vận dụng
	Biết
	Hiểu
	Vận dụng
	Biết
	Hiểu
	Vận dụng
	Biết
	Hiểu
	Vận dụng
	

	1
	Chủ đề E. Ứng dụng tin học
	Soạn thảo văn bản và phần mềm trình chiếu nâng cao
	4
(1,3,4,10)

	1
(8)

	
	5
(13a,13b, 15a, 15b,15d)
	2
(13c, 15c)
	1
(13d)
	
	
	4
(17)
	9
	3
	5
	42,5%
4,25 điểm

	2
	Chủ đề F. Giải quyết vấn đề với sự trợ giúp của máy tính
	Lập trình trực quan
	4
(2,5,6,9)
	3
(7,11,12)
	
	3
(14a, 14b, 16a)
	2
(14c, 16d)
	3
(14d,16b,16c)
	
	4
(18)
	4
(18)
	7
	9
	7
	57,5%
5,75 điểm

	Tổng số lệnh hỏi
	8
	4
	
	8
	4
	4
	
	4
	8
	16
	12
	12
	

	Tổng số điểm
	3,0
	4,0
	3,0
	4,0
	3,0
	3,0
	

	Tỉ lệ %
	30%
	40%
	30%
	40%
	30%
	30%
	



[bookmark: bookmark77]BẢN ĐẶC TẢ ĐỀ KIỂM TRA CUỐI HỌC KÌ II
MÔN: TIN HỌC LỚP 8

	TT
	Chủ đề / Chương
	Nội dung/đơn vị kiến
thức
	Yêu cầu cần đạt
	Số câu hỏi ở các mức độ đánh giá

	
	
	
	
	TNKQ
	Tự luận

	
	
	
	
	Nhiều lựa chọn
	Đúng / Sai
	

	
	
	
	
	Biết
	Hiểu
	Biết
	Hiểu
	Vận dụng
	Hiểu
	Vận dụng

	1
	Chủ đề E. Ứng dụng tin học
	Soạn thảo văn bản và phần mềm trình chiếu nâng cao
	Nhận biết
- Biết khái niệm đánh số trang, đầu trang và chân trang, đưa video, liên kết vào trang chiếu (Câu 10,15a,15b,15d)
- Biết bản mẫu, mẫu định dạng có sẵn trong powerpoint (Câu 1,3,4,13a,13b)
Thông hiểu
- Hiểu cách sử dụng, đánh số trang, đầu trang và chân trang (Câu 15c)
- Nắm được các thao tác định dạng nâng cao cho trang chiếu (Câu 8,13c)
Vận dụng
– Sử dụng được phần mềm soạn thảo:
+ Thực hiện được các thao tác: chèn thêm, xoá bỏ, co dãn hình ảnh, vẽ hình đồ hoạ trong văn bản, tạo danh sách dạng liệt kê, đánh số trang, thêm đầu trang và chân trang, tạo sản phẩm số. (Câu 17)
– Sử dụng được phần mềm trình chiếu:
+ Chọn đặt được màu sắc, cỡ chữ hài hoà và hợp lí với nội dung.
+ Đưa được vào trong trang chiếu đường dẫn đến video hay tài liệu khác. 
+ Thực hiện được thao tác đánh số thứ tự và chèn tiêu đề trang chiếu. 
+ Sử dụng được các bản mẫu (template). (Câu 13d) 
+ Tạo được một số sản phẩm là văn bản có tính thẩm mĩ phục vụ nhu cầu thực tế. 
+ Tạo được các sản phẩm số phục vụ học tập, giao lưu và trao đổi thông tin trong phần mềm trình chiếu.
	4
	1
	5
	2
	1
	
	4

	2
	Chủ đề F. Giải quyết vấn đề với sự trợ giúp của máy tính
	Lập trình trực quan
	Nhận biết
- Nhận biết được các cấu trúc điều khiển (Câu 6,16a) 
- Biết được thuật toán (Câu 5,9,14a,14b)
- Biết xác định được thứ tự các bước giải bài toán trên máy tính 
-Biết được khái niệm hằng, biến, kiểu dữ liệu, biểu thức (Câu 2)
- Gỡ lỗi chương trình
Thông hiểu
Nêu được các kiểu dữ liệu trong scratch, cách sử dụng biến ở các chương trình đơn giản trong môi trường lập trình trực quan, xác định được thuật toán trong bài toán cụ thể (Câu 7,11,12,14c,18)
- Hiểu được kết quả hoạt động của các cấu trúc điều khiển (Câu 16d)
Vận dụng
– Sử dụng được các khái niệm hằng, biến, kiểu dữ liệu, biểu thức ở các chương trình đơn giản trong môi trường lập trình trực quan (Câu 14d, 18)
– Mô tả được kịch bản đơn giản dưới dạng thuật toán và tạo được một chương trình đơn giản. 
– Thể hiện được cấu trúc tuần tự, rẽ nhánh và lặp ở chương trình trong môi trường lập trình trực quan (Câu 16b,16c)
- Phát hiện và gỡ lỗi chương trình (Câu 14d)
Vận dụng cao
– Chạy thử, tìm lỗi và sửa được lỗi cho chương trình 
	4

	3

	3
	2

	3

	4
	4

	Tổng số lệnh hỏi
	
	8
	4
	8
	4
	4
	4
	8

	Tổng số điểm
	
	3.0
	4.0
	3.0

	Tỉ lệ%
	
	30%
	40%
	30%
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